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1. Dulezité

Tato elektronickd uZivatelskd prirucka je
uréena pro kazdého uZivatele tohoto monitoru
Philips. Pred pouZzivdnim monitoru si prectéte
tuto uZzivatelskou prirucku. Obsahuje dilezité
informace a poznamky k pouzivani vaseho
monitoru.

Zaruka Philips je platnd, pokud je vyrobek
pouzivdn pro navrzenou potrebu v souladu

s ndvodem a po prilozen( origindlu faktury
nebo pokladnim dokladem, oznacujicim datum
nédkupu, jméno prodejce a modelové a vyrobnf
¢islo vyrobku.

1.1 Bezpecnostni opatreni a udrzba

€ Varovani

Pouziti kontrol, Uprav nebo postupt jinym

zpUsobem nez je stanoveno v této dokumentaci

muze vést k ohroZenf Sokem, elektrickym a/

nebo mechanickym rizikdim.

Prectéte si a dodrzujte tyto instrukce pri

zapojovani a pouzivani vaseho PC monitoru.

Pouzivani

*  Nevystavujte monitor primému slune¢nimu
zérenf, velmi silnym jasnym svétldm a
udrzujte jej mimo dosah jinych zdrojd tepla.
Dlouhé vystaveni tomuto typu prostredf

muZe mit za nasledek zménu barev a
poskozeni monitoru.

»  Odstrarite veskeré predméty, které by
mohly spadnout do vétracich otvord nebo
zabranit dostatecnému chlazeni elektroniky
monitoru.

*  Nezakryvejte vétracl otvory ve skifice.

*  Umlistéte monitor na takové misto, ze
kterého bude elektrickd zdstrcka a zdsuvka
snadno pristupna.

* Jestlize jste vypnuli monitor odpojenim
napdjectho kabelu nebo kabelu napdjectho
adaptéru, pred pripojenim kabelu pockejte
6 sekund, aby monitor fungoval normdiné.

* Vzdy pouzivejte napdjeci kabel schvéleny
spolecnostf Philips. Pokud napd jeci kabel
chybi, obrat'te se na nejblizsi servisnf
stredisko. (Viz informace o strediscich
zdkaznické péce)

*  Béhem pouZivdni nevystavujte monitor
nadmémym otresim nebo ndrazim.

* Pri pouzivani nebo premistovdni do
monitoru nekopejte a zabrarite pripadnému
padu.

Udrzba

*  Aby byl monitor chrdnén pred moznym
poskozenim, nevyvijejte na panel LCD
nadmeémy tlak. Pri premistovani zvedejte
monitor za rdm; pfi zveddni monitoru
nesahejte rukou nebo prsty na panel LCD.

* Nebudete-li monitor dels{ dobu pouZzivat,
odpojte jej ze zasuvky.

* Pred ocisténim mime navihéenym
hadrfkem monitor odpojte ze zdsuvky.
Je-li vypnuté napdjent, Ize obrazovku otrit
suchym hadrikem. K ¢isténi monitoru nikdy
nepouzivejte organickd rozpoustédla, jako
napfiklad alkohol nebo Eistice s obsahem
¢pavku.

» Zabrarite nebezped( Urazu elektrickym
proudem nebo trvalého poskozenf
monitoru a chrarite monitor pried prachem,
destém, vodou nebo nadmérné vihkym
prostredim.

* Pokud dojde k namoceni monitoru, co
nejdrive jej osuste suchym hadrikem.

*  Vnikne-li do monitoru cizf ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrarite ciz( ldtku nebo vodu
z monitoru a odeslete jej do servisniho
strediska.

*  Monitor neskladujte ani nepouzivejte
na mistech vystavenych teplu, primému
slunecnimu zdreni nebo extrémnim
teplotdm.

*  Chcete-li zachovat optimdlni vykonnost
monitoru a prodlouZit jeho Zivotnost,
pouzivejte jej na mist&, které splfiuje
nasledujici rozsahy teplot a vihkosti.



* Teplota: 0-40°C 32-95°F
*  Vlhkost: 20-80% relativni vihkosti

Dulezité informace pro vypaleni obrazu/
zdvojeného dosvitu

* Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky. Bude-li
na vasem monitoru zobrazen neménici
se staticky obsah, vzdy aktivujte aplikaci
pro pravidelnou obnovu obrazovky.
Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,,zobrazenf
duchud”.
., Vypéleni*, , dosvit" nebo ,zobrazenf
duchd" je dobre zndmy jev u technologie
panell LCD. V mnoha pripadech , vypaleni*,
,,dosvit"* nebo ,,zobrazeni duchd" postupné
zmizi po urcité dobé mimo provoz.

(D Vystraha

Selhanf aktivace sporic¢e obrazovky nebo aplikace
pro pravidelné aktualizovdni obrazovky mdze mit
za ndsledek vdzné priznaky ,vypdleni*, , dosvitu"
nebo , zdvojeného dosvitu”, které nezmizi a
nelze je opravit. Na vySe uvedené poskozen( se
nevztahuje zdruka..

Servis

* Kyt pldsté mdze otevrit pouze kvalifikovany
servisni pracovnik.

*  Pokud je pro opravu vyzadovana
dokumentace nebo integrace, obratte se
na nejblizsi servisni stredisko. (Viz kapitola
,,Stredisko zdkaznické péce')

* Informace o prevédzenf najdete v Casti
,, Technické Udaje".

*  Neponechdvejte monitor v auté nebo v
zavazadlovém prostoru auta na primém
slunci.

© Poznimka

Pokud monitor nefunguje spravné nebo pokud
si nejste jisti, jaké kroky je treba provést po
provedeni pokynU v této prirucce, obrat'te se na
servisniho pracovnika.

1.2 Vysvétleni zapisu

Nasledujici pododdily popisujf zpUsob zdpisu,
ktery se pouzivd v této prirucce.

Poznamky, upozornéni a vystrahy

Na strankdch této prirucky mizete narazit na
text, ktery je opatfeny symbolem a je vytistén
tucné nebo kurzivou. Takové useky obsahujf
pozndmky, upozornéni a vystrahy. Jejich pouzitf
je nasledujict:

€& Pozniamka

Tento symbol oznacuje dlleZité informace a
ndvrhy, které poméhajf Iépe vyuzit pocitacovy
systém.

© Upozornéni

Tento symbol oznacuje informace, které
objasniujf, jak se vyhnout moznému poskozenf
zaf{zen( nebo ztrdté dat.

D Vystraha

Tento symbol oznacuje nebezped( télesného
ubliZzenf a vysvétluje, jak se danému problému
vyhnout.

Nekteré vystrahy se mohou objevit v rizné
podobé a nemusf byt uvozeny symbolem.V
takovém pripade je konkrétni vyznacenf vystrahy
nar{zeno Uradem pro regulaci.



1.3 Likvidace produktu a obalového
materialu

Likvidace elektrickych a elektronickych
zarizeni - WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may not
be disposed of with normal household waste.
You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2. Sestaveni monitoru

2.1 Instalace

El Obsah krabice

QSmjﬁart

PHILIPS

Power Cable *VGA Cable

*V zavislosti na zemi

2] Namontujte stojanek podstavce

1.

Umistéte monitor obrazovkou dold na
mekky a hladky podklad, aby nedoslo k
poskrdbdni obrazovky.

Pripojte/nasurite sloupek podstavce k
monitoru tak, aby zacvakl na misto.

Uchopte monitor obéma rukama a
pripevnéte stojanek podstavce do sloupku
podstavce.




H Pripojeni k pocitaci

203V5LSB/203V5LSU/203V5LSB2/203V5LSU2

PHILIPS

(1) Vstup stfidavého napdjenf
© VstupVGA
© imek proti kradezi Kensington

203V5LHSB2

PHILIPS

T;
1

I

(1] Vstup str{davého napdjenf
O VstupVGA

O Vstup HDMI
(4]

amek proti krddezi Kensington
Pripojeni k pocitaci

1. Pevné pripojte napdjeci kabel k zadnf stran&
monitoru.

N

Vypnéte pocitac a odpojte jeho napdject
kabel.

3. Pripojte signdlovy kabel monitoru do video
konektoru na zadnf strané pocitace.

4. Zapojte napdjeci kabel pocitace a monitoru
do nejblizsi zasuvky.
5. Zapnéte pocitac a monitor. Jestlize se

na monitoru objevi obraz, instalace je
dokoncena.

2.2 Ovladani monitoru

a Popis vyrobku z éelniho pohledu

2] Popis zobrazeni funkci na obrazovce

Co je nabidka na obrazovce (OSD)?

Funkci nabidky obrazovky (On-Screen Display,
OSD) jsou vybaveny viechny monitory

LCD Philips. Umozriuje koncovému uzivateli
upravovat vlastnosti obrazovky nebo vybirat
funkce monitoru prfmo prostrednictvim
zobrazeného okna s pokyny. Nize je uveden
priklad prfjemného rozhrani obrazovky:

i

203V5LHSB2:
R

| Slouzi k ZAPNUTI a VYPNUTI
O napdjeni monitoru.

_@ Slouzi ke zméné zdroje
vstupniho signalu.

- Nastaven( trovné jasu.

Nastaveni Grovné kontrastu.

Automatické nastaveni monitoru.

Nastaven( jazyka

(D Zobrazeni informaci

D Ukon¢eni OSD




Jak nastavit nabidku OSD jedinym tlaéitkem? Nabidka OSD

1.Tlagftko na dolnf strané predntho rdmecku ma NiZe je uveden celkovy pohled na strukturu
funkce vypinace a nastaveni nabidky OSD. OSD. Tento prehled mlzete vyuzit, budete-li
chtit pozdé&ji prozkoumat riiznd nastavent.
— Main menu
VGA
—Input E DVI (available for selective models)
p— HDMI (available for selective models)
. : p v, v _ r— Picture Format — Wide Screen, 4:3

2Jednim stisknutim dolntho tlacitka zapnéte [—Picture

. — Brightness — 0~100
monitor.

— Contrast — 0~100
3.Nynf dalsim stisknutim dolniho tlacitka na [— SmartContrast  — On, Off
prednim rdmecku vstupte do nabidky OSD — OverScan — On,Off

) —Audio — Volume — 0~100
- —~—T—1— (available for — Mute — On, Off
= selective models) L—  Audio Source — Audio In, HDMI
203V5LHSB2: +—Color r— Color Temperature — 6500K, 9300K

I — sRGB
T e O Red: 0-100
Green: 0~100
- ---I == Blue: 0~100

4 Nyﬂll miete rych\y’m opakovanym stisknutim +—Language — English, Deutsch, Espafiol, ENnvik, Francais, Italiano,

Maryar, Nederlands, Portugués, Portugués do Brazil,

dolniho tladitka vybrat libovolnou funkci. Polski , Pycckuit, Svenska, Suomi, Turkge, Cestina,
Tisknutim tlagftka se bude modré politko Vipaiceia, RS, SERRAR S, BARES, 9ol
posouvat vpravo. Jakmile modré policko oznacf
poZadovanou volbu, mizete dolnf tla¢itko [——OSD Settings — Horizontal — 0~100
uvolnit. Vybér je jednosmémy: vzdy postupuje — Vertical — 0~100
jednim smérem a potom se vrdti na zacdtek — Transparency — Off.1,2,3, 4
nabidky.

L— OSD Time Out  — 5s, 10s, 20s, 30s, 60s

5.Modré policko zlstane na vybrané funkci
priblizné 3 sekundy, ikona funkce trikrat zablikd LSetup — Auto
pro potvrzeni vybéru na 1. drovni nabidky OSD

) — H. Position — 0~100
a funkce bude aktivovédna.
— V. Position — 0~100
6.Chcete-li vybrat poZadovany jazyk, stisknéte L phase — o100
dolnf tlacitko, v nabidce OSD vyberte symbol
— Clock — 0~100

,zemekoule" a pockejte, az se aktivuje. V

nabidce se zobrng nékolik jazykovych moZnosti. — i‘e;;’flligggn — On, Off
Opakovanym stisknutim dolniho tlacitka

prochdzejte jazyky. Ponechdnim modrého
poli¢ka na vybraném jazyku bude proveden
jeho vybér a aktivace.

[ Reset — Yes, No

L Information

7.Chcete-li nastavit jas nebo kontrast, stisknéte
dolnf tlacitko, vyberte a aktivujte. DalSimi
stisknutim dolnho tlacitka upravte. Vybér je
jednosmémy: vzdy postupuje jednim smérem a
potom se vratl na zacatek nabidky.



El Poznimka k rozligeni 2.3 Odpojte stojanek podstavce a

Tento monitor je urcen pro optimdlni vykon pri podstavec

nativnim rozliseni 1600 x 900 pri 60 Hz. Kdyz je

monitor zapnut pfi jiném rozlideni, na obrazovce Hl Demont stojanku podstavce

se zobrazf vystraha: Pro optimdin vysledek Nez zacnete demontovat podstavec monitoru,

pouzijte rozligen 1600 x 900 pri 60 Hz. postupujte podle pokynl niZe, aby se zabranilo

jakémukoli moznému poskozeni nebo zranént.

1. Umistéte monitor obrazovkou dold na
B Fyzické funkce mekky podklad, aby nedoslo k poskrdbdn{

Néklon obrazovky.

2. Stisknéte zajistovaci svorky a oddélte
stojdnek podstavce od sloupku podstavce.

3. Pro odpojenf sloupku podstavce stisknéte
uvolriovacf tlacitko.




© Poznimka

Tento monitor je kompatibilni's 100mm x
100mm montaznim rozhranim kompatibilnim
se standardem VESA.

PHILPS

100mm




3. Optimalizace Obrazu

3.1 SmartContrast

El Cojeto?

Jedinecnd technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastn pomér monitoru LCD pro maximdlni
vizudlni Cistotu a pozitek ze sledovani. Zvysuje
podsvicen( pro jasnéjsi, ostrejsi a jasnéjsi obraz
nebo snizuje podsviceni pro jasné zobrazenf
obrazu s tmavym pozadim.

E1 Proé to potrebuii?

Zadéte nejvy¥f vizudlni gistotu a pohodl
sledovan( jakéhokoli typu obsahu. SmartContrast
dynamicky r{di kontrast a upravuje podsvicenf
pro jasné, ostré a jasné zobrazeni her a videa
nebo pro zobrazenf jasného, citelného textu
pro kancelarskou praci. Omezenim spotreby
monitoru Setrfte ndklady a prodluzujete zZivot
vaseho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v
redlném Case analyzovat zobrazeny obsah a
upravovat barvy a ridit intenzitu podsviceni. Tato
funkce bude dynamicky vylepSovat kontrast pro
skvély zazitek pri prohlizeni fotografil nebo hranf
her.

3.2 Philips SmartControl Lite

Novy software SmartControl Lite od
spolecnosti Phillips umozriuje ovlddat monitor
prostrednictvim snadno pouzitelného grafického
rozhrani na obrazovce. Slozita nastaveni jsou
minulosti, protoze tento uzivatelsky prijemny
software vas provede jemnym vyladénim
rozlieni, kalibraci barev, nastavenim frekvence/
faze, nastavenim bilého bodu RGB atd.

Tento software zaloZeny na pritazlivych
animovanych ikondch kompatibilni se systémem
Windows 7, ktery je vybaven nejnovéjsi
technologil v jddrovém algoritmu pro rychlé

zpracovan( a odezvu, je pripraven rozsifit vasi
zkusenost s monitory Philips!

El Instalace
* Postupujte podle pokynd a dokoncete
instalaci.

*  Mulzete spustit po dokoncenf instalace.

*  Chcete-li spustit pozdéji, mizete klepnout
na zastupce na pracovni plose nebo na
panel nastroju.

PHILIPS www philips.com/welcome

Recuired seps Monitor driver and software installation
Syt roquiremenss

- PC running Windows . Vi, XP, 2000, 9.

Philps SmareControl

1. Sytam support Windows 7. Viss XP.
Por ied Chnese

[y —

Prvni spusténi —Wizard (Privodce)

*  Pfi prvnim spusténi po instalaci prejde
SmartControl Lite automaticky na Wizard
(PrAvodce).

» Tento privodce vds provede podrobnym
nastavenim vykonu monitoru.

* Prlvodce mdlZete rovné€zZ spustit pozdéji z
nabidky Plug-in (Zasuvny modul).

* Dalsi moznosti mlzete nastavit bez
privodce prostrednictvim podokna
Standard (Standardnf).




88 smartControl 2- Philps 22581 (CS30715000001) |2\ X; B smartControl 2 - Phiips 22581 (C530715000001) {Z]

SmartControl Lite PHILIPS SmartControl Lite PHILIPS

Hieand Contrast

0 calbrate your dispiay to get the most . o ™

encourage you to use the simple Adus the Contras (use the idr) o keep datal i
tuning process by selecting the Start Wizard button. ighter mage areas

This process involve:

ves 3 series of steps that wil et you 1. Rase the Contrast unti the numbers 1and 2
tune your dispiay and save the settings. are no longer vsble.
1. Choose the Start Wizard button. 2. Slowly lower the Contrast to make the
2 the steps outined in this process. numbers 2 and 3 reappear. The number 1
Q 3 Soveyour setngeforfuture Use, <houl remain barely Vel

Adjust Audio “Adiust
A srgntness
\% Auto Piot °
- \g Contrast
cobr 3 Color a
= AR
. Focus Contrast. 50
g
Weard ." = ./
2 Poston
Optons presets Undo Reset

> o 2

Muki Moniors \Q
Hep

Start Waard

E1 Spusténi s podoknem Standard W S i o0
(Standardni): SmartControl Lite PHILIPS

Nabidka Adjust (Nastaveni): e

» Nabidka Adjust (Nastaveni) umoZzriuje Yo s s o e i
upravit Brightness (Jas), Contrast (Kontrast), P e st e vt s
Focus (Ohnisko), Position (Poloha) a e 2y 5 e b e o e
Resolution (Rozlisent).

*  Muizete postupovat podle pokynd a provést
nastaveni. Goor AR

+  Cancel (St va uzivatele, cheete-| ; X

ancel (Storno) vyzivd uzivatele, chcete-li . - .

ukondit instalaci.

Choose Auto Setuj

Brghtness

Pitch 50

=

Postion

Options Undo Auto Setup

@ smartControl 2- Philps 22581 (C530715000001) (2)(X) B Resolution
SmartControl Lite PHILIPS

Help

Brightness
Improper adjusted Brightness wil rsul 3 oss of
detail in darker image areas. Adjust the Brightness for
the best possble pcture qualy.

1. Lower the Brightness to the minimurn level

2. Rase the Brightness to the desired level.

3. Adjustthe Brightness 3s nesded to achieve 8 SmartControl 2-Phips 22581 (cs30715000001) (Z)X

an equal separation of the stripes.

Adjust Gy
i {2 SmartControl Lite PHILIPS
Brightness
Position
s Use the Position buttons to center the image on
. Your deoty: Us this ool You can posion e mage
o A o o, e, o1
— Focus Brightness 100 e
= & 2. Use the Left/Right buttons to center the image
horzotal
Undo Reset Adiust

Options [
o Resolution

8rightness

Contrast

Help

%

Undo Reset

Optons

-
= i

Resolution

A

10



@ smantcontol

2. Phips 22581 (Cs30715000001) (2]

SmartControl Lite PHILIPS

Resolution

You are currently 3t 3 Preferred resolution. For your
dsplay to show crsp, clear text, colors, and images,
your display should be set to fs Preferred resolution.
T your display s at a Non-Preferred resolution, clck

on the Preferred button to change your resokition to

T~ Enable Resolution Notfier

Brightness Picture Format
I~ 43 aspect ratio
Contrast
Color AR
A
- Focus
A
\g Postion

Preferred

g
g
2]

Resolution

Nabidka Color (Barva):

Nabidka Color (Barva) umozriuje upravit
RGB, Black Level (Uroveﬁ cerné), White
Point (Bily bod), Color Calibration (Kalibrace
barev).

Md0Zete postupovat podle pokynt a provést
nastavent.

V nésledujicl tabulce vyhledejte polozku
podnabidky na zdkladé vaseho vstupu.
Priklad pro Color Calibration (Kalibrace
barev)

2 - Philps 22581 (€530715000001) {Z\X)

PHILIPS

B SmartControl
SmartControl Lite

Black Level

Improperly adjusted Black Level wil resut i  loss of
detai n darker mage areas. Adjust the Black Level for
the best possble picture qualty.
1. Adjust the black level of the Red, Green, and
Blue using the sider bars.

u 1]

Adijust RGB
Red 50
Black Level = Q +
Green =
Color White Pont - QO &
- Ble 20
Display Gamma o O &
-
Undo Reset
Options Calbration
Help

"

8 smartControl

SmartControl Lite

\ﬂ 1)

Adjust Rea
Color White Pont
w5y =
Disply Gamma
-
Options Galbration
Help
8 smartControl

SmartControl Lite

u n

Adjust RGB
Color White Point
, s
-l
Options Calbration
Help
8 SmartControl

SmartControl Lite

Adjust Ree
Black Level
Cobor Whee Pont
AN i
Dplay Gamma
-,
Options Galbration
Help

2

PHILIPS

2 - Phips 22581 (CS30715000001)

White Point

‘White Point i the point at which equal combmations
of red, green, and blue lignt at ful intensty create
white. This effects the overall color qualty. F
most accurate colors cick the Reset button then
select the Whie Point.
1. Please select the White Pont value for the best
possble color qualty.

White Point 6500K

Undo Reset

2 phips 22581 (CS30715000001) (2 (%)
PHILIPS

Display Gamma
imrma 3 component of the pxelbrightness n 3
diplay. A lower Gamma value produces brighter pixes
and 2 higher Gamma value produces darker pixels. The

defauk value for Gamma i 2.2

o adjust Gamme, Smartlmage must be et to O
Click the SmartImage Off button before adjusting
Gamma,

1. Use the sider to select the desred Gamm.

Diplay Gamma

(Y

Smartimage Off

Undo Reset.

2 - Philps 22581 (C530715000001) (¥ X
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Calibration

Your dispiay needs to be properly calibrated i order
for t o produce the widest range of cokrs accurately.
Calibration should ahways take place as the bst tuning
step in the process. Remember to recalbrate any time
you make individual adjustments to image qualey or
whenever you move your dsplay to 2 new location.
Make all other necessary adjustments to image
qualey frst.

2. Press Show Me to leam how to use the
calibration took.
3. Finaly, press Start to begn the calibration

process.

R Enable color caibration
Color software desgned i colaboration with Joseph

jomes.
Protected by U.S. Patent Ho. 6,686,953

Show Me start

Quick View



1. Tlagitko ,,Show Me" (Predvést) spustf
vyukovy program pro kalibraci barev.

2. Start (Spustit) — zahdji sekvenci kalibrace
barev o 6. krocich.

3. QuickView (Rychlé zobrazeni) nacte
zobrazeni pred/po.

4. Chcete-li se vrétit na hlavni stranku Color
(Barva), klepnéte na tlacitko Cancel
(Storno).

5. Enable color calibration (Povolit kalibraci
barev) — ve vychozi konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta, kalibraci
barev nelze provést a tlacitka rychlé
zobrazenf nejsou k dispozici.

6. Na kalibracni obrazovce musf byt zobrazeny
informace o patentech.

Calibration Screen (Obrazovka kalibrace)
prvni barvy:

* Tlacftko Previous (Predchozi) je
deaktivovdno az na obrazovku druhé barvy.

*  Tlacitko Next (Dalsi) slouzi k prechodu na
nasleduijici cil (6 cild).

*  Tlacitko Konecny slouzi k prechodu na File
> Presets (Soubor > podokno Predvolby).

*  Tlacitko Cancel (Storno) slouzi k ukoncenf
uzivatelského rozhranf a k ndvratu na
strdnku zdsuvnych moduld plug-in.

Options>Preferences (Moznosti>Predvolby) —
Tato moznost bude aktivni pouze po vybéru
polozky Preferences (Predvolby) v rozeviraci
nabidce Options (Moznosti). Na nepodporova-
ném zobrazovacim zarizeni' s podporou DDC/
Cl jsou k dispozici pouze karty Help (Ndpovéda)
a Options (Moznosti).
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SmartControl Lite PHILIPS

Preferences

Zobrazi nastaven( aktudlnich predvoleb.
Zaskrtnuté tlacitko aktivuje funkci.
Zaskrtdvaci policko je prepinac.

PoloZka Enable Context Menu (Povolit
mistni nabidku) na pracovni plose je ve
vychozi konfiguraci zaskrtnutd (Zapnuto).
Po aktivaci polozky Enable Context

Menu (Povolit mistni nabidku) se zobrazi
vybéry SmartControl Premium pro funkce
Select Preset (Vybrat predvolbu) a Tune
Display (Ladéni zobrazeni) na pracovni
plose klepnutim pravym tlacitkem mysi na
mistni nabfdku. Volbou moZnosti Disabled
(Deaktivovdno) bude polozka SmartControl
Premium odstranéna z mistni nabidky
pravym tlacitkem mysi.

PoloZka Enable Task Tray (Povolit ikonu na
hlavnim panelu) je ve vychozi konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Povolit mistnf nabidku se zobrazi nabidka
SmartControl Lite na hlavnim panelu.
Klepnutim pravym tlacitkem mysi na ikonu
na hlavnim panelu se zobrazi moznosti
nabidky Help (Ndpovéda), Technical
Support (Odborna pomoc), Check for
Update (Vyhledat aktualizace), About

(O aplikaci) a Exit (Konec). Kdyz je
deaktivovdna polozka Enable task tray menu
(Povolit nabidku na hlavnim panelu), ikona
na hlavnim panelu zobrazuje pouze moznost
EXIT (KONEC).



* PoloZka Run at Startup (Spustit pri startu) je
ve vychoz( konfiguraci zaskrtnutd (Zapnuto).
Kdyz je tato polozka deaktivovdna, funkce
SmartControl Lite se nespustf pri startu
nebo nebude na hlavnim panelu. Funkci
SmartControl Lite Ize spustit pouze
prostrednictvim zdstupce na pracovni
plose nebo prostrednictvim souboru
programu. Kdyz toto poli¢ko nenf zaskrtnuté
(Deaktivovdno), zddnd predvolba nastavend
pro spusténi pfi startu nebude nactena.

* Enable transparency mode (Aktivovat rezim
prahlednosti) (Windows 7, Vista, XP).
Vychozi nastaveni je O % neprdhlednost.

Options>Input (Moznosti>Vstup) — Tato
moznost bude aktivni pouze po vybéru
polozky Input (Vstup) v rozeviraci nabidce
Options (Moznosti). Na nepodporovaném
zobrazovacim zafizeni' s podporou DDC/CI
jsou k dispozici pouze karty Help (Napovéda)
a Options (Moznosti). Zddné dal3f karty funkce
SmartControl Lite nejsou k dispozici.

W smartcontol 2. phips 22581 (cs30715000001) (Z] X

SmartControl Lite PHILIPS

Tnput

=

Adjust Audio

Color Input

Options P

Y

-

Help

Analog In Digital In

» Zobrazi podokno s pokyny Source (Zdroj)
a nastaven( aktudiniho zdroje vstupu.

* U zobrazovacich zarizen( s jednim vstupem
neni toto podokno zobrazeno.
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Options>Audio (Moznosti>Zvuk) — Tato
moznost bude aktivni pouze po vybéru polozky
Audio (Hlasitost) v rozeviraci nabidce Options
(Moznosti).

Na nepodporovaném zobrazovacim zarizenf s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

B smartControl 2 - Phiips 22581 (C530715000001) ()X,

SmartControl Lite PHILIPS

Audio

Adiust Audo

\% Auto Prot
-
Color. Input

Options Presats

Y o

TES Volume 100
Help

Undo

Help>User Manual (Napovéda>Uzivatelska
prirucka) —Tato moznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelskad
prirucka) v rozeviraci nabidce Help (Ndpovéda).
Na nepodporovaném zobrazovacim zarizeni s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

PHILIPS

8 smartcontrol

SmartControl Lite

User Manual

Adijust

-

I ®
Color

Dspley ID

@

Options X

©

P

User Manual Tech. Support



Help>Version (Napovéda>Verze) —Tato
moznost bude aktivni pouze po vybéru
polozky Version (Verze) v rozeviraci nabidce
Help (Ndpovéda). Na nepodporovaném
zobrazovacim zarizen( s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda) a
Options (MoZznosti).
8 smartcontrol

2 - Phiips 22581 (C530715000001) (') X

SmartControl Lite PHILIPS

Context Sensitive menu (Mistni nabidka)
Context Sensitive Menu (Mistni nabidka) je
ve vychozi konfiguraci Aktivovana. Nabidka
bude zobrazena po zaskrtnuti polozky Enable
Context Menu (Povolit mistni nabidku) v ¢asti
Options > podokno Preferences (Moznosti >

podokno Predvolby).

@ SmartControl
Helect Preset L3
Tune Display

Context Menu (Mistni nabidka) obsahuje 3

polozky:

*  SmartControl Lite - po vybéru se zobrazf
obrazovka About (O) aplikaci.

* Select Preset (Vybrat predvolbu) — nabizf
hierarchickou nabidku uloZenych predvoleb
pro okamzité pouzitl. Aktudlné vybrand
predvolba je oznacena zaskrtnutim. V
rozeviracl nabidce Ize rovnéZ vybrat polozku
Predvolby vyrobce.
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* Tune Display (Ladéni zobrazen() — otevre
ovlddaci panel SmartControl Lite.

Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu lze zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl
Lite na hlavnim panelu. Klepnutim levym
tlacitkem lze spustit aplikaci.

Help

Technical Support
Check For Update
About

Exik

Hlavni panel obsahuje pét polozek:

* Help (Ndpovéda) — pristup k souboru
s User Manual (uzivatelskou priruckou):
Otevr'e soubor s User Manual (uzivatelskou
priruckou) v okné vychoziho prohlizece.

* Technical Support (Odbornd pomoc) —
zobraz/ stranku odborné pomoci.

* Check for Update (Vyhledat aktualizace) —
zobrazi Uvodn( stranku PDI a porovnad verzi
uzivatele s nejaktudlnéjsi dostupnou verzi.

* About (O aplikaci) — zobrazi podrobné
referencni informace: verze produktu,
informace o vydanf a ndzev produktu.

*  Exit (Konec) - ukoncf SmartControl Lite

Chcete-li znovu spustit funkci SmartControl Lite,
vyberte polozku SmartControl Lite z nabidky
Program, poklepejte na ikonu na pracovni plose
pocitae nebo restartujte pocital.

SmartCon

PHILIPS

SmartControl
ersion 3.20
chune-standard-R2007-01-04-1151-23
Copyright 1883-2007 Portrait Displays, Inc.
Patents Pending




Deaktivovana nabidka hlavniho panelu

Kdyz je hlavni panel deaktivovan ve slozce
Preference (Predvolby), je k dispozici pouze
¢ast EXIT (KONEC). Chcete-li funkci
SmartControl Lite zcela odstranit z hlavniho
panelu, deaktivujte polozku Run at Startup
(Spustit pri startu) v ¢asti Options>Preferences
(Moznosti>Predvolby).

& Pozndmka

Veskeré ilustrace v této casti jsou pouze
orientacnf.Verze softwaru SmartControl se
muUze zménit bez predchoziho upozornén.
Vzdy navstivte oficidini webové stranky Portrait
na adrese www.portrait.com/dtune/phl/enu/
index a stdhnéte si nejnovéjsi verzi softwaru
SmartControl.
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4. Technické udaje

Obraz/displej

Typ panelu LCD TFT-LCD
Podsvicenf LED

Velikost panelu 19,5" S (49,4 cm)
Pomér stran 169

Rozte¢ obrazovych bodu 0,26 x 0,26 mm

Jas

200 cd/m? for 203V5LSB2/203V5LSU2/203V5LHSB2;
250cd/m? for 203V5LSB/203V5LSU

SmartContrast 10.000.000:1
Kontrastni pomér (typ.) 600:1
Doba odezvy (typicka) 5ms

Optimalni rozliseni

1600 x 900 pii 60 Hz

Zorny Uhel

90° (H) / 50° (V) pfi C/R > 10

Moznosti pripojeni
Vstup signdlu

Barevnost displeje 16,/M
Vertikalni obnovovaci frekvence | 56Hz - 76Hz
Horizontélnf frekvence 30kHz - 83kHz
sRGB ANO

VGA (analogovy)(203V5LSB/203V5LSU/203V5LSB2/203V5LSU2)
HDMI(203V5LHSB2)

Vstupni signal
Usnadnéni

Usnadnéni pro uzivatele

Oddélend synchronizace, synchronizace podle zelené

0

Anglictina, némcina, Spanélstina, rectina, francouzstina, italstina,

Jazyky nabidky OSD madarstina, holandstina, portugalStina, brazilskd portugalstina,
rustina, polstina, Svédstina, finstina, turectina, cestina, ukrajinstina,
zjednodusend ¢instina, tradicni ¢instina, japonstina, korejstina

Uchyt VESA 100 x 100 mm

Dalsi usnadnénf

Zamek Kensington

Kompatibilita s technologif
Plug & Play

Podstavec
Ndklon

DDC/CI, sRGB, Windows 8/ Windows 7/ Vista/XP, Mac OSX,
Linux

-3/+10

Napajeni
Zapnuto

203V5LSB2/203LSU2: 158W (typ.), 16,71W (max.)

203V5LSB/203V5LSU: 18.29W (typ.),18.98W (max)
203V5LHSB2: 17.69W/(typ.),18.46W(max.)

Spanek (Pohotovost) 0,5W

Vypnuto 0,5W

Indikdtor napdjenf Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blikd)
Napdjenf Vypdleni, 100-240VAC, 50-60Hz
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Rozméry

Vyrobek s podstavce (SxVxH)

465 x 345 x 169 mm

Vyrobek bez podstavee (SxVxH)

465 x 282 x 48 mm

Hmotnost

Vyrobek s podstavcem 2,33kg(LED)
Vyrobek bez podstavce 2,03kg(LED)
Vyrobek s obalem 3,23kg(LED)

Provozni podminky

Shoda a normy
Prohldseni o shodé

Teplotni rozsah (provoz) 0°Caz 40 °C
Teplotni rozsah (mimo provoz) -20°C az 60°C
Relativni vihkost 20% az 80%

MTBF 30 000 hod(LED)
ROHS ANO

EPEAT Silver (www.epeat.net)
Balenf 100% recyklovatelny
Energy Star ANO

CE Mark, FCC Class B, CU, SEMKO, ETL,
1SO9241-307, SASO, EPA, CB, PSB, KUCAS, TBS CoC

Barva Cemd
Povrchova Uprava Textura

& Pozniamka

N

. Certifikat EPEAT Gold nebo Silver je platny pouze tam, kde spolec¢nost Philips zaregistruje produkt.

Informace o stavu registrace ve vasi zemi viz www.epeat.net.

N

www.philips.com/support.

Tyto Udaje se mohou zménit bez predchoziho ozndment. Stéhnéte si nejnovejsi verzi letdku z webu



4.1 Rezimy rozliseni a predvoleb

Maximalni rozliseni
1600 x 900 pri 60 Hz

Vodorovna Rozliseni Svisla
frekvence frekvence
(kHz) (Hz)
3147 720 x 400 70.09
3147 640 x 480 59.94
35 640 x 480 66.67
37.86 640 x 480 72.81
375 640 x 480 75
37.88 800 x 600 60.32
46.88 800 x 600 75
48.36 1024 x 768 60
60.02 1024 x 768 75.03
4477 1280 x 720 59.86
63.89 1280 x 1024 60.02
79.98 1280 x 1024 75.03
60 1600 x 900 60
& Poznimka

Upozorfiujeme vas, ze tento monitor funguje
nejlépe pri nativnim rozliseni 1600 x 900 pri
60 Hz. Pro dosazeni optimaln( kvality zobrazenf
dodrzujte toto doporucené rozlisent.



5. Rizeni spotieby

Pokud je v daném pocitaci nainstalovdn software

nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdze automaticky
snizit svou spotrebu energie, neni-li pouzivan.
Pokud pocfta¢ rozpoznad vstup z kldvesnice,
mysi nebo jiného vstupniho zarizenf, monitor se

automaticky ,,probud*. Nasledujici tabulka uvadf

spotrebu energie a signalizaci této funkce pro

automatickou Usporu energie:

203V5L5B2/203V5LSU2(Analog only)

Definice rizen( spotreby

ReZim VESA| Video | H-synch. [ V-synch. | Spotieba energie | Barva indikdtoru LED
Aktivai | ZAP. | Ano | Ano 1157?\/\/{/ ((ZZ ) B4
Spanek [ VYP. Ne Ne 05W (typ.) Bild (blikd)
Vypnuto | VYP. = = 05W (typ.) VYP.
203V5LSB/203V5LSU

Definice rizenf spotreby

ReZim VESA| Video | H-synch. [ V-synch. | Spotieba energie | Barva indikdtoru LED
1829W ),
A | Z#P. | Ano [ Ao | siafaw (:Z';; B4
Spanek [ VYP. Ne Ne 05W (typ.) Bila (blikd)
Vypnuto | VYP. 05W (typ.) VYP.

Definice rizenf spotreby

ReZim VESA| Video | H-synch. | V-synch. | Spoteba energie | Barva indikdtoru LED
; 1769W (typ.), )
Al AP. Al
ktivni Z no Ano 1846W (max) Bil&
Spanek | VYP. [ Ne Ne 05W (typ) B4 (blikd)
Vypnuto | VYP. 0,5W (typ.) VYP.

Nasledujici konfigurace se pouzivd pri mérenf
energetické spotreby tohoto monitoru.

e Nativni rozliseni: 1600 x 900
*  Kontrast: 50%
e Jas: 200 nitd or 250 nit

*  Barevnd teplota: 6500 K s pIné bilym
vzorkem

& Poznamka
Tyto Udaje se mohou zménit bez predchoziho
oznament.
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6. Informace o
regulaci

Lead-free Product

Lead free display promotes
environmentally sound recovery
 and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

EPEAT

(www.epeat.net)

@  The EPEAT (Electronic
Q@’b Product Environmental
& Assessment Tool) program
evaluates computer desktops,
laptops, and monitors based on 51 environ-
mental criteria developed through an extensive
stakeholder consensus process supported by
US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards

»  EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).

»  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

+ EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

* 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

»  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

* 1S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e GS EK1-2000:2011 (GS mark requirement).

» prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-Il (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

Energy Star Declaration

(www.energystar.gov)

Py /s an ENERGY STAR® Partner, we

Mﬁ? have determined that this product

meets the ENERGY STAR”
guidelines for energy efficiency.



& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

€& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de l'article
15 Des regles de la FCC. Ces limites sont
congues de facon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si l'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir |'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

* Brancher '€quipement sur un autre circuit
que celui utilisé par le récepteur

e Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur 'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

“This davice belongs to catagory B devices a8 described in EN 55022, unless it is spaci-
cally stated that it i a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up 1o 30 metars). The user of the
davice is obligad to take all staps necessary o remove sources of interfarance to tals-
communication or other devicas.

Pokd neni na fypovém &tk potstase uvedena, # spedé do do tidy A podie EN 55022,
spada automaticky do tfidy B podle EN 55022, Pro zafizen! zafazend do tFidy A (chranné
pésma 30m) podie EN 5502 platl nésleduficl. Dojde-li k rullan! telskomunikatich nebo
finjich zafizani e uivatal povinnen provést takova opatfgni, atry nen odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagania Polskiege Centrum Badan i Certyfikacji

Urzdeenic powinne byt zasitane # poiazds 2 preylaczanyem obwodem ochronnye (gniazdo
Kalkiem ). Wapdlgracuface i sohq urzadzenia (kompuser, monitor, druksrkal powinny by sasilane
2 tegn samego drbdla.

Instalacja elekerycena pomiesscrenia powinn mwie
praneel swarciami, w pestaci berpiecanika o warto:
W el catkowitego wybserenia urzadzenia 2 siect zasilania, nalezy wyjné wivczkg kabla
easilajacega = poazdka, kidre powinno ssidowad s w pobliz urmJJanm:I!\t Batwi dosiepne.
Zaak bezpiecsefstwa "B” potwiendss podnosé uresdseia 2 wynaganiami bezpiecsehstva
whytkowania sawartyini w PN-ULTA2107 § PR-BOE-G

w przeworksie fzowym rezecrowa achrang
marmienavwe] e wicksej ni 164 (amperiuw).

Pozostale instrukcje bezpieczensiwa

* Niemaledy urywad wiyceek sdapterowych lub usuwaé kolka abwedu ackrornego 2 wiyeeki.
Jekeli Lu\m‘WIILJLJ LRy |:|1:\:\Jlural‘ra o naledy whyd preediuzace 3-pylowego 2
System kmpalerowy rnlny sabezpivcryt prred nagtymi, chwilow
ac eliminatora preepied, urradrenia dopasow
berzakidceniowe irinia zasilania.

tic nie leZalo na kablach systemu kompuierowego, arz aby kable nie
dzse tokna byloby na sie nadeptywad lub poryksd sig o nie.
inych plynbw s system komputerowy.

warostami lub spad-
X
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Réntgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Gerdtes befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
a5 Abs. 4 der Réntgenverordnung erfilit
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAR NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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7. Péce o zakazniky a zaruka

7.1 Postup pri vadnych pixelech
plochého panelu spolecnosti
Philips

Spolecnost Philips se snazi doddvat vyrobky
vyrobnich postup( vyroby v tomto odvétvi a
prosazuje prisnou kontrolu kvality. Defektim
obrazovych bodd nebo dil¢ich obrazovych
bodl u panelt TFT LCD, které se pouzivajf
pro ploché monitory, se nicméné nékdy nedd
zabranit. Zadny vyrobce nemuize zarudit, ze
vSechny panely budou bez defektd obrazovych
bod, ale spole¢nost Philips zarucuje, ze kazdy
monitor s neprijatelnym poctem defektl bude
v rdmci zdruky opraven nebo vymeénén.Tento
text vysvétluje jednotlivé druhy defektl na
pixelech a urcuje Unosnou urover chybovosti
pro kazdy druh. Aby bylo mozné uplatnit zarucnf
opravu nebo vyménu, musi pocet defektnich
obrazovych bodd panelu TFT LCD presdhnout
tuto Uroveri Unosnosti. Na monitoru napriklad
nesmf byt vice defektnich dil¢ich obrazovych
bodd nez 0,0004 %. Déle, protoze nékteré typy
kombinaci vad pixell jsou lépe postrehnutelné
nez jiné, stanovuje pro né spolecnost Philips
jesté vetsi ndroky na kvalitu. Tato norma se
dodrzuje celosvétove.

subpixely subpixely subpixely

vy
pixelly

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se skldda ze tif
subpixeld v zakladnich barvéch Cervené, zelené a
modré. Kdyz je mnoho pixeld pohromadé, tvorf
obraz. Kdyz viechny subpixely ur¢itého pixelu
svitf, jevi se tyto tfi subpixely spole¢né jako
jediny bily pixel. Kdyz jsou vechny tmavé, jevi
se tyto tfi subpixely jako jeden cerny pixel. Dalsf
kombinace rozsvicenych a tmavych subpixell se
jevi jako pixely rdznych barev.
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Druhy pixelovych vad

Vady pixell a subpixeld se na obrazovce
projevuji riznymi zpUsoby. Existuji dva druhy
vad pixelu a v rdmci téchto druhd je nékolik
typd subpixelovych vad.

Defekty svétlych bodu

Defekty svétlych bodl se projevuji jako
obrazové body nebo dil¢f obrazové body, které
vzdy sviti nebo jsou 'aktivni'. Svétly bod je dil¢f
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena tmava plocha. Existujf

nasledujici typy defektl svétlych bodd:

Jeden cerveny, zeleny nebo modry subpixel

l ¢

Dva soundlezici subpixely:
- Cerveny + modry = fialovy
- Cerveny + zeleny = Zluty
- zeleny + modry = svétle modry

Tri soundlezicl rozsvicené subpixely (jeden bily
pixel).



& Poznimka

Cerveny nebo modry svétly bod musi byt o
vice nez 50 procent jasnéjsi, nez sousedni body;
zeleny svétly bod je o 30 procent jasngjsi, nez
sousedn( body.

Defekty tmavych bodu

Defekty tmavych bodd se projevuji jako
obrazové body nebo dil¢i obrazové body, které
nikdy nesvitf nebo jsou ,,neaktivni. Tmavy bod je
dil¢i obrazovy bod, ktery vystupuje z obrazovky,
kdyZ je na monitoru zobrazena svétld plocha.
Existuji nasledujici typy defektd tmavych bodd:

Vzdalenost pixelovych vad

Protoze vady pixell a subpixell stejného

typu, které se vyskytuji blizko sebe, mohou byt
patrnéjsi, urcuje spolecnost Philips i tolerance na
vzdélenost vad pixeld.

Tolerance vad pixelQ

Aby bylo mozné uplatnit opravu nebo vyménu
kvlli defektnim obrazovym bodlm v zdru¢nf
dobé, musi panel TFT LCD plochého monitoru
Philips vykazovat defekty obrazovych bodu
nebo dil¢ich obrazovych bod(, které prekracujf
tolerance uvedené v ndsledujicich tabulkdch.

KAZY JASNYCH BODU

PRIJATELNY POCET VAD

1 trvale svitici bod 3
2 sousedni trvale svitici body 1
3 sousedn( trvale svitici body (nebo 1 trvale svitici bily bod) 0
Vzddlenost mezi dvéma kazy jasnych bodi* >15 mm
Celkovy pocet kazl jasnych bodd viech typl 3

KAZY CERNYCH BODU
1 tmavy bod

PRIJATELNY POCET VAD
5 nebo méné

2 sousedni tmavé body

2 nebo méné

3 sousedni tmavé body 0
Vzddlenost mezi dvéma kazy cemych bodi* >15 mm
Celkovy pocet kazt ¢ernych bodd viech typl 5 nebo méné

KAZy bodl celkem

PRIJATELNY POCET VAD

Celkovy pocet kazll jasnych nebo ¢ernych bodut viech typl

5 nebo méné

© Poznamka

1. 1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod

2. Tento monitor je kompatibilni se standardem ISO 9241-307. ( ISO 9241-307: Ergonimicky
pozadavek, analyza a metody testovdni shody pro elektronickd zobrazovac( zarizen)

3. Norma 1SO9241-307 je naslednikem drivéjsi normy ISO13406, kterd byla zrusena organizaci 1ISO
(International Organisation for Standardisation) ke dni: 2008-11-13




7.2 Péce o zakazniky & zaruka

Podrobné informace o zdruce a pozadavku na dodatecnou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz muizete kontaktovat mistni centrum péce o zdkazniky na nize

uvedenych telefonnich &islech.

Kontaktni informace pro oblast LATINSKE AMERIKY:

Zemé Telefonni stredisko Cislo zakaznické péce

Brazil 0800-7254101
Vermont

Argentina 0800 3330 856

Kontaktni informace pro SEVERNi AMERIKU:

USA.

Telefonni stredisko

EPl-e-center

ASC

Qwantech

Cislo zakaznické péce

(877) 835-1838

Canada

EPl-e-center

Qwantech

(800) 479-6696

Kontaktni informace pro oblast ZAPADNI EVROPY:

Zemé ASC Cislo zakaznické péce Cena
Austria RTS +43 0810 000206 €007
Belgium E Care +32 078 250851 €0.06
Cyprus Alman 800 92 256 Free of charge
Denmark Infocare +45 3525 8761 Local call tariff
Finland Infocare +358 09 2290 1908 Local call tariff
France Mainteq +33 082161 1658 €0.09
Germany RTS +49 01803 386 853 €0.09
Greece Alman +30 00800 3122 1223 Free of charge
Ireland Celestica +353 01 601 1161 Local call tariff
[taly Anovo [taly +39 840 320 041 €0.08
Luxembourg E Care +352 26 84 30 00 Local call tariff
Netherlands E Care +31 0900 0400 063 €0.10
Norway Infocare +47 2270 8250 Local call tariff
Poland MSI +48 0223491505 Local call tariff
Portugal Mainteq 800 780 902 Free of charge
Spain Mainteq +34 902 888 785 €0.10
Sweden Infocare +46 08 632 0016 Local call tariff
Switzerland ANOVO CH +41 02 2310 2116 Local call tariff
United Kingdom Celestica +44 0207 949 0069 Local call tariff

27




Kontaktni informace pro oblast STREDNI A VYCHODNI EVROPY:

Telefonni

Cislo zakaznické péce

stredisko

+37517 217 3386

Belarus NA BA +375 17 217 3389
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA MR Service Ltd +385 (01) 640 1111
Czech Rep. NA Asupport 420 272 188 300
s [ =
Georgia NA Esabi +995 322 91 34 71
+36 1 814 8080(General)
Hungary NA Profi Service +36 1814 8565(For AOC&Philips
only)
Kazakhstan NA Classic Service l.l.c. +7 727 3097515
+
Latvia NA ServiceNet LV +§;1 ggzggzz
Lithuania NA UAB Servicenet Ig;g ;ZO%%%:;?%?;EH?QS)
Macedonia NA AMC +389 2 3125097
Moldova NA Comel +37322224035
Romania NA Skin +40 21 2101969
Russia NA CPS +7 (495) 645 6746
;egﬁitaefegm NA Kim Tec d.o.o. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
the republic| ServiceBy +375 17 284 0203
of Belarus
Turkey NA Techpro +90 212 444 4 832
Wit NA Comel +380 5627444225
NA Topaz +38044 525 64 95

Kontaktni informace pro Cinu:

Cina

Cislo zékaznické péce: 4008 800 008
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Kontaktni informace pro oblast APMEA:

Telefonni
stredisko

Cislo zakaznické péce

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / NA Company: Smart Pixels Hong Kong:Tel: +852 2619 9639
Macau Technology Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 1o 56477
Indonesi NA PT. CORMIC SERVISINDO +62-21-4080-9086 (Customer Hotline)
onesid PERKASA +62-8888-01-9086 (Customer Hotline)
Korea NA Alphascan Displays, Inc. 1661 — 5003
Malaysia NA R-Logic Sdn Bhd +603 5102 3336
Pakistan NA TVONICS Pakistan +92-213-6030100
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3966
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa | NA Computer Repair Technologies | 011 262 3586
Israel NA Eastronics LTD 1-800-567000
FPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA Company Ltd. - Ho Chi Minh [ +84 5113.562666 Danang City
City Branch +84 5113.562666 Can tho Province
Philippines NA EA Global Supply Chain (02) 655-7777; 6359456
Solutions ,Inc.
Armenia
Azerbaijan
Georgia NA Firebird service centre +97 14 8837911
Kyrgyzstan
Tajikistan
Uzbekistan | NA Ef d”'ko Plus Private Enterprise | | 59571 784650
Turkmenistan | NA Technostar Service Centre +(99312) 460733, 460957
T4 ) TAE=L— - PR
Japan NA L x— 03-5676-6022
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8. Odstranovani probléma a
Casté dotazy

8.1 Odstranovani problému

Na této strdnce jsou uvedeny problémy,
které mize odstranit uzivatel. Pokud problém
pretrvavd i po vyzkousenf téchto resent,
kontaktujte zdstupce sluzeb pro zdkazniky
spolecnosti Philips.

El Bé&iné problémy

Zidny obraz (indikitor LED napajeni nesviti)

»  Zkontrolujte, zda je napdjec( kabel pripojen
k elektrické zdsuvce a do zadnf ¢asti
monitoru.

*  Nejdrive zkontrolujte, zda se vypinac na
predni strané monitoru nachdzi ve OFF
(VYPNUTE) poloze a stisknéte jej do ON
(ZAPNUTE) polohy.

Zadny obraz (indikator LED napajeni je bily)

» Zkontrolujte, zda je zapnuty pocftac.

*  Zkontrolujte, zda je kabel signdlu rddné
pripojen k pocitadi.

»  Zkontrolujte, zda nejsou ohnuté koliky na
pripojovac( stran& kabelu monitoru. Pokud
ano, opravte nebo vymérite kabel.

* Pravdépodobné je aktivovdna funkce rizenf
spotreby

Obrazovka rika

Attention

Check cable connection

» Zkontrolujte, zda je kabel monitoru fddné
pripojen k pocitaci. (Rovnéz viz Strucnd
prirucka).

e Zkontrolujte, zda nejsou ohnuté koliky
kabelu monitoru.

*  Zkontrolujte, zda je zapnuty pocital.

Tlacitko AUTO nefunguje
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Automatickd funkce je pouzitelnd pouze
v rezimu VGA-analogovy. Pokud vysledek
nenf uspokojivy, mizete provést ru¢nf
Upravy prostrednictvim nabidky OSD.

€& Pozniamka
Automatickd funkce nenf pouzitelnd v
rezimu DVI-digitdIni, protoze je zbytecnd.

Viditelné znamky koure nebo jiskreni

*  Neprovddéjte zddné kroky pro odstrariovan(
problému

*  Pro zajisténi bezpecnosti ihned odpojte
monitor od zdroje napéjenf

* |hned kontaktujte zdstupce sluzeb pro
zdkazniky spolecnosti Philips.

E1 Problémy se zobrazenim

Obraz neni vystredén

»  Upravte polohu obrazu pomoci funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

*  Upravte polohu obrazu pomoci polozek
Phase/Clock (Féze/frekvence) v &asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovladaci prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz se chvéje na obrazovce

»  Zkontrolujte, zda je kabel signdlu rddné a
bezpecné pripojen ke grafické desce nebo k
pocitaci.

Dochazi ke svislému blikani

*  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v ¢asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Dochazi k vodorovnému blikani




*  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v &asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddac(i prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo prilis
tmavy
*  Upravte kontrast a jas na obrazovce OSD.

,Dosvit®, ,,vypaleni* nebo ,,zobrazeni duchi*

zlstane po vypnuti napajeni.

*  Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,,zobrazen{
duchd”. ,Vypaleni*, ,dosvit"* nebo
,,Zzobrazeni duchd" je dobre zndmy jev
u technologie paneld LCD. V mnoha
pripadech ,,vypdleni, , dosvit"* nebo
,,zobrazenf duchd" postupné zmizf po
urcité dob& mimo provoz.

* Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky.

* Bude-li na vaSem monitoru LCD zobrazen
nemeénici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.

*  Véiné priznaky ,vypdleni”, ,dosvitu" nebo
,,zobrazenf duchl' nezmizi a nelze je
opravit. Na vysSe uvedené poskozeni se
nevztahuje zdruka.

Obraz je zdeformovany. Text je nejasny nebo

rozmazany.

* Nastavte rozlieni zobrazeni pocftace
na stejny rezim, v jakém se nachdzf
doporucené nativni rozliseni obrazovky
monitoru.

Na obrazovce se objevuji zelené, cervené,

modré, tmavé a bilé tecky

*  Zbyvajicl body jsou normadini viastnostl
tekutych krystal( pouzivanych soucasnou
technologii. DalSi podrobnosti viz pravidla
pro obrazové body.
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Svétlo indikatoru ,,napajeni* je prilis silné a

rusi

* MdZete nastavit intenzitu svétla indikdtoru
,napdjeni" v ¢asti Power LED (Indikdtor
LED napdjeni) v casti Setup (Nastaven)
v OSD Main Controls (Hlavni ovlddacf
prvky nabidky OSD).

Potrebujete-li dalsi pomoc, viz seznam
Informacni strediska pro zdkazniky a kontaktujte
zéstupce sluzeb pro zdkazniky spolecnosti
Philips.

8.2 Obecné casté dotazy

OTAZKA 1: Kdyz nainstaluji svaij monitor, co
mam udélat, kdyz se na obrazovce
zobrazi zprava ,,Cannot display this
video mode* (Tento rezim videa
nelze zobrazit)?

Doporucené rozliseni pro tento

monitor: 1600 x 900 pri 60 Hz.

*  Odpojte viechny kabely, potom pripojte
pocita¢ k monitoru, ktery jste pouzili predtim.

* V Start Menu (nabidce Start) operacniho
systému Windows vyberte Settings/Control
Panel (Nastaveni/Ovlddaci panely). V okné
Control Panel (Ovlddaci panely) vyberte
ikonu Display (Zobrazenf). Na panelu Display
Control (Zobrazeni — vlastnosti) vyberte kartu
,Settings' (Nastaveni). Na karté nastaven(

v poli oznaceném ,,desktop area” (pracovni
plocha) presurite posuvnik na 1600 x 900
obrazovych bodu.

*  Klepnéte na ,, Advanced Properties' (Upresnit),
nastavte polozku Refresh Rate (Obnovovact
frekvence) na 60 Hz a potom klepnéte na OK.

*  Restartujte pocitac a zopakovanim kroku 2 a 3
ovérte, zda je pocita¢ nastaven na 1600 x 900
pri 60 Hz.

*  Vypnéte pocitac, odpojte stary monitor a
znowu pripojte monitor LCD Philips.

»  Zapnéte monitor a potom zapnéte pocitac.

Odpovéd:

OTAZKA 2: Jaki je doporuéena obnovovaci
frekvence monitoru LCD?
Doporucend obnovovaci frekvence
u monitort LCD je 60 Hz. V pripadé
jakéhokoli ruseni na obrazovce ji

Odpovéd:



OTAZKA 3:

Odpovéd:

OTAZKA 4:
Odpovéd:

OTAZKA 5:

Odpovéd:

OTAZKA 6:

Odpovéd:

OTAZKA 7:

Odpovéd:

muZete nastavit na 75 Hz a uvidite,
zda ruseni zmizi.

Co jsou soubory .inf a .icm na disku
CD-ROM? Jak Ize nainstalovat
ovladace (.inf a .icm)?

Jednd se o soubory ovladace
monitoru. Pi instalaci ovladacl
postupujte podle pokyn( v
uzivatelské prirucce. Pri prvnf instalaci
bude pocita¢ pravdépodobné
pozadovat ovladace monitoru
(soubory .inf a .icm) nebo disk s
ovladaci. Postupujte podle pokynl a
vlozte (doprovodny disk CD-ROM),
ktery je soucdstf této sady. Ovladace
monitoru (soubory .inf a .icm)
budou nainstalovany automaticky.

Jak mam upravit rozliseni?
Dostupna rozlisenf urcuje grafickd
karta/ovladac grafiky a monitor.
Pozadované rozliseni mdzete vybrat
v &asti Control Panel (Ovlddacf
panely) systému Windows® v &4sti
,Display properties" (Zobrazenf -
vlastnosti).

Co kdyz se béhem nastaveni
monitoru ztratim prostrednictvim
nabidky OSD?

Jednoduse stisknéte tlacitko OK a
potom volbou ,,Reset” (Obnovit)
obnovte vsechna ptvodn( nastavenf
vyrobce.

Je obrazovka LCD odolna proti
poskrabani?

Obecné se doporucuje nevystavovat
povrch panelu nadmémym uderdim
a chrdnit jej pred ostrymi nebo
tupymi predmeéty. Pri manipulaci

s monitorem nevyvijejte na povrch
panelu Zddny tlak ani silu. Mohlo by
to negativné ovlivnit vase zarucnf
podminky.

Jak Ize distit povrch monitoru
LCD?
Pro bézné cisténi pouzijte Cisty
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a mekky hadrik. Pro ddkladné
cisténi pouzijte izopropyl
alkohol. Nepouzivejte zddnd jind
rozpoustédla, jako etylalkohol,
etanol, aceton, hexan atd.

OTAZKA 8: Lze ménit nastaveni barev
monitoru?
Odpovéd:  Ano, nastaveni barev mizete zménit

prostrednictvim nabidky OSD podle
nasledujicich krokd:

»  Stisknutim tlacitka ,,OK" zobrazte nabidku
OsD.

+ Stisknutim tlacftka ,,Down" (Sipka dolti)
vyberte volbu ,,Color” (Barva) a stisknutim
tlacitka ,,OK" prejdéte na nastaven( barev. K
dispozici jsou tfi nastaven( (viz nize).

1.

Color Temperature (Teplota barev):

k dispozici je dvou nastaveni: 6500K a
9300K. Pfi nastaven( v rozsahu 6500K
vypadajf barvy na panelu ,teplé s
cervenobilym barevnym ténem", zatimco
pri nastaveni teploty 9300K vypadajf
barvy na panelu ,,studené s modrobilym
barevnym ténem®.

sRGB: standard pro zajisténi spravné
prenosu barev mezi rliznymi zarizenimi
(napr:. digitdni fotoapardty, monitory,
tiskdrny, skenery atd.)

User Define (Uzivatelské): uzivatel si mize
zvolit vlastni nastaveni barev upravenim
Cervené, zelené a modré slozky.

© Poznimka:

Méreni svétla barvy, které vyzaruje predmét pri
zahrivani. Toto méren( je vyjadieno v absolutnim
méritku (stupné Kelvina). Nizsi teploty Kelvina,
napriklad 2004K; jsou Cervené; vyssi teploty, jako
napriklad 9300K; jsou modré. Neutrdlni teplota je
bild pri 6504K.

OTAZKA 9:  Lze pFipojit tento monitor LCD
k libovolnému pocitacdi, pracovni
stanici nebo pocitaci Mac?

Odpovéd: Ano.Vsechny monitory LCD

Philips jsou plné kompatibilni se
standardnimi pocitaci, pocitaci
Mac a pracovnimi stanicemi. Pro
pripojeni monitoru k systému
Mac mlze byt zapotrebi kabelovy



adaptér. Dal3i informace vam
poskytne nejblizsi obchodnf
zastupce Philips.

OTAZKA 10: Jsou monitory Philips LCD

Odpovéd:

OTAZKA 11:

Odpovéd:

(D Vystraha

vybaveny technologii Plug-and-
Play?

Ano, tyto monitory jsou
kompatibilni s technologii Plug-
and-Play v opera¢nim systému
Windows 8, Windows 7,Vista, XP
NT, Mac OSX a Linux.

Co znamena Ipéni obrazu,
vypaleni obrazu, dosvit nebo
,,duch” v souvislosti s panely
LCD?

Dlouhodobé neprerusované
zobrazeni nehybného nebo
statického obrazu mdzZe zpUsobit
,vypdleni" obrazovky, rovnéz
znamé jako ,,dosvit"* nebo
,zobrazen( duchl”. ,Vypdlenf*,
,dosvit"* nebo ,,zobrazenf duchi*
je dobre zndmy jev u technologie
paneld LCD.V mnoha pripadech
,vypdleni”, , dosvit" nebo
,zobrazenf duchd" postupné zmizf
po urcité dobé mimo provoz.
Pred ponechadnim monitoru bez
dozoru vzdy aktivujte sporic
obrazovky.

Bude-li na vasem monitoru LCD
zobrazen neménici se staticky
obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky.

Selhanf aktivace sporice obrazovky nebo aplikace
pro pravidelné aktualizovani obrazovky mize mit
za nasledek vazné priznaky ,vypéleni”, ,, dosvitu"
nebo ,zdvojeného dosvitu", které nezmizi a
nelze je opravit. Na vyse uvedené poskozen( se
nevztahuje zdruka.
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OTAZKA 12: Proc se na displeji nezobrazuje

Odpovéd:

ostry text a pro¢ maji
zobrazené znaky zubaté okraje?
V&s monitor nejlépe pracuje pri
svém nativnim rozlisenf 1600

x 900 pri 60 Hz. Pouzivejte

toto rozliseni pro dosazenf
optimalniho zobrazen.
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